Perforce 2006.2
FTP Plug-in User’s Guide

December 2006

This manual copyright 2001-2006 Perforce Software.
All rights reserved.
Perforce software and documentation is available from http://www.perforce.com. You may download and use
Perforce programs, but you may not sell or redistribute them. You may download, print, copy, edit, and redistribute
the documentation, but you may not sell it, or sell any documentation derived from it. You may not modify or
attempt to reverse engineer the programs.
Perforce programs and documents are available from our Web site as is. No warranty or support is provided.
Warranties and support, along with higher capacity servers, are sold by Perforce Software.
Perforce Software assumes no responsibility or liability for any errors or inaccuracies that may appear in this book.
By downloading and using our programs and documents you agree to these terms.
Perforce and Inter-File Branching are trademarks of Perforce Software. Perforce software includes software
developed by the University of California, Berkeley and its contributors.
All other brands or product names are trademarks or registered trademarks of their respective companies or
organizations.

Table of Contents
Preface

About This Manual ....................................................... 5
Why an FTP server? ...........................................................................................5
Feedback on this guide ......................................................................................5

Chapter 1

Installing and Configuring P4FTP.............................. 7
System requirements..........................................................................................7
Product architecture ...........................................................................................8
Installation and configuration ..........................................................................9
Downloading P4FTP......................................................................................9
Choosing a port number ...............................................................................9
Starting P4FTP manually ............................................................................10
(Optional) Configuring P4FTP to start automatically.............................11
Creating Perforce users and client workspace specifications ................12
Specifying a template for undefined client specifications......................17
Using config files ..........................................................................................18
Verifying your installation ..........................................................................18
Automatically syncing a Perforce client workspace....................................20
P4FTP configuration options ..........................................................................21
P4FTP startup options......................................................................................22
Configuring Macromedia Dreamweaver with P4FTP ................................24
Overview .......................................................................................................24
Creating web sites ........................................................................................25
Sample configuration...................................................................................27
Working in a team environment ................................................................27
Updating a live web site..............................................................................29
Troubleshooting notes: adding files...........................................................30
Configuring HoTMetal PRO 6.0 .....................................................................31
Configuring Hot Dog Professional 6 .............................................................31
Configuring AceHTML ...................................................................................32

Chapter 2

Troubleshooting P4FTP .............................................. 33
Error messages ..................................................................................................33

Perforce 2006.2 FTP Plug-in User’s Guide

3

Table of Contents

Cannot make connection to host ............................................................... 33
Cannot open remote folder ........................................................................ 33
Can’t clobber writable file .......................................................................... 33
Error opening local file ............................................................................... 33
Other questions ................................................................................................ 33
Why aren’t my Dreamweaver files visible in Perforce?......................... 33
I created a directory using FTP and it disappeared - why?................... 34
My command-line FTP client/Dreamweaver froze after
connecting/prompting for P4FTP - why?................................................ 34
Why do I have .lck files in my workspace/depot?................................. 34
Using a command-line FTP client ................................................................. 34

Chapter 3

Perforce and FTP Differences .................................... 35
FTP differences ................................................................................................. 35
How files are managed on the client computer ...................................... 35
How files are transferred............................................................................ 35
The pwd command ..................................................................................... 36
Supported FTP commands......................................................................... 36
Perforce differences ......................................................................................... 37
Changelist numbering ................................................................................ 37
Changelist descriptions .............................................................................. 37
Filetypes ........................................................................................................ 38
Workspace management ............................................................................ 38
Concurrency ................................................................................................. 38
Standards compliance and limitations ......................................................... 39

Index.............................................................................. 41

4

Perforce 2006.2 FTP Plug-in User’s Guide

Preface

About This Manual

This guide tells you how to install, configure and run the Perforce FTP Plug-in (P4FTP). For
details about how to use or administer Perforce, see the documentation at
http://www.perforce.com.

Why an FTP server?
P4FTP enables an FTP client to access files in Perforce depots. For example, you might store
shareware in a Perforce depot and use P4FTP to enable non-Perforce users to download
the files.

Many development tools commonly used in web development environments are not
integrated with software configuration management (SCM) software. The majority of
these tools have a built in FTP client for publishing developed works. The Perforce FTP
Plug-in uses this built-in FTP client to enable you to use SCM software in conjunction with
your web development tools. When you use P4FTP in place of standard FTP, your files are
kept in a Perforce depot under version control.

Feedback on this guide
Please send any comments or corrections to manual@perforce.com.
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Chapter 1

Installing and Configuring
P4FTP

P4FTP is both an FTP server and a Perforce client application. Files that are downloaded
from the FTP server are retrieved from the depot, and files that are uploaded are put into

the depot. For details, see “Product architecture” on page 8.
This chapter tells system administrators how to install and configure P4FTP.

System requirements
There are four components you need to install and configure to use FTP to access files in
Perforce depots:
• FTP client: a command-line client or a web authoring tool such as Dreamweaver, which
has an FTP client embedded in it. The FTP client communicates with P4FTP.
• P4FTP: accepts requests from an FTP client and communicates with a Perforce server.
• Perforce server: manages files in central repositories called depots. (Note: if you use
versions lower than 2000.2, P4FTP does not display files size when you issue the FTP ls
command.)
• Perforce client application: enables you to perform Perforce tasks directly. The most
commonly-used Perforce client applications are P4V, the P4 command-line interface,
and P4Web.
For details about installing Perforce, refer to the Perforce System Administrator’s Guide.
The following table shows you where the components are installed. Note that you can
install two or more components on the same computer. However, the Perforce server is
typically a remote computer, because there is no advantage to be gained by locating your
depot on the same computer as the workspace files.
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Computer

Description

System requirements

Client computer

The computer where you
work on files.

FTP client

Network access to the FTP
server
Perforce client application
(recommended)

FTP server

The computer where you
run P4FTP.

P4FTP

Network access to the
Perforce server computer
Perforce client application
(required)

Perforce server

The computer where the
Perforce server runs and
where your file repository
resides.

Perforce server

Product architecture
The following figure shows a high level view of the architecture of P4FTP:
FTP Commands
FTP Client

P4 Commands
Perforce
Server

P4FTP
Files

Files

There are some important differences in behavior between P4FTP and a normal FTP server.
For details about these differences, refer to Chapter 3, Perforce and FTP Differences.
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Installation and configuration
To install P4FTP, perform the following steps:
1.

Download P4FTP.

2.

Choose a port number.

3.

Start P4FTP.

4.

Optionally, configure P4FTP to start automatically when you reboot the computer on
which it runs.

5.

Create Perforce users and workspace specifications.

After you perform these procedures, you can configure web authoring tools such as
Macromedia Dreamweaver to use Perforce to store and retrieve your web site files. See
“Configuring Macromedia Dreamweaver with P4FTP” on page 24 for details. The
following sections tell you how to install P4FTP.

Downloading P4FTP
To download P4FTP:
1.

Launch a web browser and go to:
http://www.perforce.com/perforce/products/p4ftp.html

2.

On the Perforce product download web page, find the version of P4FTP that is
compatible with the platform where you intend to run it.

3.

Download the file to the directory where you intend to run it.
Note Recommended installation directories are:

• Windows: C:\Program Files\Perforce\
• UNIX: /usr/bin/ or /usr/local/bin/

Choosing a port number
P4FTP is a modified FTP server. Its default port number is 21, which is also the default port
number for standard FTP servers. To avoid port conflicts, you can assign a different port
number to P4FTP when you start it, as follows:

• Command line: specify the -l flag when you start P4FTP.
• Windows service: use the p4 set -S command option to set the P4FTPORT
environment variable for the service. For details, see “(Optional) Configuring P4FTP to
start automatically” on page 11.
Perforce 2006.2 FTP Plug-in User’s Guide
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Starting P4FTP manually
To start P4FTP manually (that is, from the command line), perform the following steps:
1.

Login as the user that you want to run P4FTP.
UNIX If you want to run p4ftpd on a privileged port (a port number lower than
1024), login as root. The default port for standard FTP servers is port 21. To
enable P4FTP to listen on a privileged port while running as a user other
than root, specify the -u username flag when you start p4ftpd.

2.

Windows users: open a DOS window.

3.

Run p4ftpd.
When starting p4ftpd, you can specify the host and port number of the Perforce
server you want to access, and optionally the port on which P4FTP accepts FTP
commands.
For example, to start p4ftpd with its default port (21) on the same computer (named
perforce) where the Perforce server is running on its default port (1666), issue the
following command:
p4ftpd

To start p4ftpd on port 1232 communicating with a Perforce server running on port
2343 on a remote computer named bigcomputer, issue the following command:
p4ftpd -p perforce.bigcomputer.com:2343 -l 1232

By default, p4ftpd submits changelists with the following description:
[P4FTPD] Automatic changelist for uploaded files

When you start p4ftpd, you can override the default description using the -t flag. In the
description, you can specify the following macros, which are expanded when the
changelist is submitted
Macro

Expands to

%user%

user name

%client%

client workspace name

%ftphost%

host name (p4ftpd host)

%time%

timestamp

For example:
p4ftpd -t "[P4FTP(%ftphost%)] submit by %user% from %client% at %time%"

10

Perforce 2006.2 FTP Plug-in User’s Guide

Chapter 1: Installing and Configuring P4FTP

(Optional) Configuring P4FTP to start automatically
You can configure P4FTP to start automatically when its host computer is rebooted.
UNIX computers
Edit the startup scripts according to the convention for your UNIX platform. If you intend
to run P4FTP on a port other than the default, be sure to set the P4FTPPORT environment
variable in the startup script.
Windows computers
To configure P4FTP to start automatically when its host computer is rebooted, create a
service as follows:
1.

At the DOS command prompt, change to the directory where the file p4ftpd.exe is
located. (This file is the one you downloaded from the Perforce web site.

2.

Create a copy of p4ftpd.exe named p4ftps.exe by issuing the following command:
cp p4ftpd.exe p4ftps.exe

3.

Create a service by issuing the following command:
svcinst CREATE -n "Perforce FTP Server" -e "fullpath/p4ftps.exe" -a

where fullpath indicates that you must specify the full location of the p4ftps.exe
file. Windows displays the following results:
Creating Service
ServiceName=Perforce FTP Server
ExeName=c:\Program Files\perforce\p4ftps.exe
Autostart requested

(To verify the service has been successfully created, use the Services control panel.)
Note The svcinst utility is installed when you install the Perforce server on
Windows NT, in the same directory as the server. For more details, refer to
http://www.perforce.com/perforce/technotes/note035.html

4.

To specify a host and port for the service, issue the p4 set command. For example,
to ensure that P4FTP listens on port 1892, issue the following command:
p4 set -S "Perforce FTP Server" P4FTPPORT=1892

You can also configure the user and client workspace name for the P4FTP service, for
example:
p4 set -S "Perforce FTP Server" P4USER=bruno
p4 set -S "Perforce FTP Server" P4CLIENT=bruno

Perforce 2006.2 FTP Plug-in User’s Guide
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To start the service manually, use the Services control panel. The service starts
automatically when you reboot your computer. To view settings, use regedit to
display \\HKEY_SYSTEM\CurrentControlSet\Services\SERVICENAME\Parameters
where SERVICENAME is the name you gave the service when you created it.

Creating Perforce users and client workspace specifications
For each user who intends to access Perforce depots using P4FTP, you must create a
Perforce user and a client workspace specification on the P4FTP server computer. Perforce
uses the client workspace specification to determine the location of its client workspace,
where it stores files on your client computer.
The following sections tell you how to create a Perforce users and client specification.
Perform these steps from a computer where P4V or the Perforce command-line interface
(p4) is installed. You can direct P4FTP to create a client specification using a template,
when a user that has not P4FTP client specification connects for the first time. For details,
see “Specifying a template for undefined client specifications” on page 17.
Using P4V
To create a Perforce user and client specification using P4V, perform the following steps.
1.

12

Launch P4V. The Open Connection dialog is displayed.
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2.

Click the New... button next to the User field. The New User dialog is displayed.

3.

Enter the information for the user you want to create and click Save to dismiss the
dialog.

4.

Click the New... button next to the Workspace field. When prompted, enter “ftp-”
followed by the name of the user you created in the preceding steps. The New
Workspace dialog is displayed.

Perforce 2006.2 FTP Plug-in User’s Guide
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5.

Enter the required information. Note that, because you define the client workspace
on the computer where P4FTP runs, you only need to correct the normdir option.
Check the following entries:

Field

Description

Host name

Specify the name of the computer where P4FTP runs. For
example:
mycomputer.mycompany.com.

Root

Specify the directory on your FTP server computer where you
want the Perforce client workspace to be located. P4FTP uses the
client workspace as temporary local storage.
Specify a location below the root directory, such as
C:\p4client. To avoid cluttering the root directory of your
client computer, do not use the root directory as the root of your
client workspace. Choose a directory that is not used by
another program or process.

Options

Check rmdir. If your Perforce depot is located on a UNIX
computer and your FTP client is located on a Windows
computer, set the LineEnd option to win.

View

Specifies the mapping of the Perforce depot to your client
workspace, to determine which files in the depot are visible to
your client computer. Do not change this entry unless you
understand Perforce client views and want to alter the
mapping.

6.

Click Save to save your changes.

The user and workspace are created. You do not need to connect to the server using P4V
for your entries to take effect.
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Using the P4 command-line interface
To create a Perforce user and client specification using the Perforce command-line
interface, perform the following steps.
1.

At the command line, issue the p4 user command. Perforce launches a text editor
and displays the Perforce User Specification form as follows.

2.

Enter the information for the new user in the User, Email, FullName, and
(optionally) Password fields.

3.

Save and close the file.

Perforce 2006.2 FTP Plug-in User’s Guide
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4.

At the command line, issue the p4 client command. Perforce display the Perforce
Client Specification form as follows:

5.

Change the entries in the following fields:

Field

Description

Client

Specify “ftp-” followed by the Perforce user name.

Host

Specify the name of the computer where P4FTP runs. For
example:
mycomputer.mycompany.com.

Root

16

Specify the directory on your FTP client computer where you
want the Perforce client workspace to be located.
Recommendation: specify a location below the root directory,
such as C:\p4client. To avoid cluttering the root directory of
your client computer, do not use the root directory as the root of
your client workspace.
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Field

Description

Client options

Change normdir to rmdir. If your Perforce depot is located on a
UNIX computer and your FTP client is located on a Windows
computer, set the LineEnd option to win.

View

Specifies the mapping of the Perforce depot to your client
workspace, to determine which files in the depot are visible to
your client computer. Do not change this entry unless you
understand Perforce client views and want to alter the
mapping.

6.

Save and close the file.

Specifying a template for undefined client specifications
To enable P4FTP to create an “ftp-” client specification for users that lack one, you can
specify a template client specification. The first time a user that lacks an “ftp-” client
specification connects, p4ftpd creates an “ftp-” client specification based on the client
template. If you do not specify a template, P4FTP requires all “ftp-” client specifications to
exist when it attempts to connect to the Perforce server.
The client template is an existing Perforce client specification. You define the client
template as described in “Creating Perforce users and client workspace specifications” on
page 12. To ensure that client roots do not conflict, you can use macros in the client root
field of the template. For example, the following client root definition directs P4FTP to
create a client root directory using the format /data/host/user:
Root: /data/%ftphost%/%user%

To ensure that client roots do not conflict, and to tailor the client view to meet your needs,
you can use macros in both the client root field and the view field of the template. For
example:.
Root:

/data/%user%

View:
//depot/main/... //ftp-template/main/...
//depot/user/%user%/... //ftp-template/%user%/...

These definitions ensure that each user’s client root is unique and map a user-specific
depot path into their client view, along with files in the //depot/main/... path.
To specify the client template that you want P4FTP to use, specify the -T flag when you
start p4ftpd. For example:
p4ftpd -T ftp-myclient-template

Perforce 2006.2 FTP Plug-in User’s Guide
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Using config files
You can use Perforce config files to specify client options for p4ftpd. A config file is a text
file containing specifications for Perforce client settings. (For detailed information about
config files, see the Perforce Command Reference.) In addition to the standard Perforce client
settings, you can specify the following P4FTP settings:
• P4FTPPORT
• P4FTPPREFIX
• P4FTPLOG

• P4FTPSYSLOG (UNIX only)
• P4FTPCHANGE

• P4FTPTEMPLATE (template client specification; see “Specifying a template for undefined
client specifications” on page 17)
For details about these settings, see “P4FTP configuration options” on page 21. Note that
p4ftpd obtains settings for P4USER, P4PASSWD and P4CLIENT from its FTP client and

therefore ignores any config file entries for these settings. Any settings that you specify on
the command line when you start p4ftpd override corresponding config file settings.

Verifying your installation
The following sections tell you how to verify that P4FTP is up and running. Note that, to
perform these procedures, your Perforce server must be running and you must have
started P4FTP as described in the previous sections.
Using the command line
To verify that you have successfully installed and configured P4FTP, issue the following
commands to start an FTP client and connect with P4FTP:
1.

At the operating system prompt, start FTP by issuing the ftp command.

2.

At the ftp> prompt, issue the open command to connect to the host where P4FTP is
running; for example, to connect to a host named “myhost” listening on port 1234:
FTP>

open myhost 1234

The message “220 Perforce P4FTP FTP Server ready” is displayed.

18

3.

If prompted, log in.

4.

Display the contents of the Perforce depot by issuing the FTP ls command. To
browse the depot and transfer files, use other standard FTP commands.

5.

To display information about commands supported by P4FTP, issue the help
command.
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Using a Web browser
To verify that you have successfully installed and configured P4FTP, perform the
following steps to use a browser to connect with P4FTP:
1.

Launch a Web browser.

2.

In the URL window, enter a URL that specifies FTP protocol, the Perforce user, and the
P4FTP host name and port.
For example, if P4FTP is running on mycomputer and listening on port 1850, enter:
ftp://mitch@mycomputer:1850

If you are using Internet Explorer, you must specify the user password (if any) in the
URL in the following format:
ftp://username:password@hostname:portnumber

3.

If prompted, enter your password and click OK.
The browser displays the contents of the depot. The following figure shows a
browser displaying a depot.

Perforce 2006.2 FTP Plug-in User’s Guide
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Automatically syncing a Perforce client workspace
To configure P4FTP to automatically sync files to a specified workspace, you can specify
the following options when you start p4ftpd. You cannot start p4ftpd in single-threaded
mode (using the -f flag) if you want to use its automatic sync feature.
Valid options are as follows:
• -O autosync: Sync the entire client view every 300 seconds (five minutes).
• -O syncdelay=n: Sync every n seconds. The default interval is 300 seconds. If you
specify this option, omit the -O autosync option.
• -O syncspec=valid_sync_specification: Sync only the specified files.
valid_sync_specification can be any file specification you can use with the p4 sync
command, including wildcards, labels or changelist numbers. By default, the entire
client view is synced. If you specify this option, omit the -O autosync option.
The workspace that is automatically synced is taken from the environment of the p4ftpd
process when it is started, including Perforce config files. (For details about configuring
workspace settings, refer to the Introducing Perforce. For details about using config files,
refer to the Perforce Command Reference.)
You can specify these settings:
• when you start p4ftpd, or
• by setting the P4FTPOPTIONS environment variable before you start p4ftpd, or
• in a Perforce config file in or above the directory from which p4ftpd was started.
If you run p4ftpd as a Windows NT service, you must use the P4FTPOPTIONS
environment variable to set options.
Example: The following example sets p4ftpd to sync the entire client view every five minutes:
p4ftpd -O autosync
Example: The following example sets p4ftpd to sync the files in the external_web directory

every hour:
p4ftpd -O syncdelay=3600 -O syncspec=//external_web...
Example: The following example shows how to specify the preceding settings in a config file.
P4FTPOPTIONS="syncdelay=3600,syncspec=//external_web..."

20
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P4FTP configuration options
You can use the following environment variables to configure P4FTP.
Environment variable

Description

P4FTPPORT

Specifies the TCP port to listen on. The default port is 21.

P4FTPPREFIX

Specifies the prefix to be prepended to the user’s login to
determine the corresponding Perforce client workspace. The
default prefix is “ftp-”.

P4FTPCHANGE

Specifies the description to be included when P4FTP submits
changelists. Overrides the default description.

P4FTPLOG

Specifies the file where P4FTP logs errors. By default, errors are
sent to stderr.

P4FTPOPTIONS

Set multiple options, including automatic syncing of the
current workspace, how often to check for submitted
changelists and which files to sync. Use commas to separate
multiple options. For example:
P4FTPOPTIONS=dwlocking,autosync,syncdelay=10

For details about the options you can specify, see “P4FTP
startup options” on page 22.
P4FTPSYSLOG

UNIX only: If set, enables logging using syslog().

Perforce 2006.2 FTP Plug-in User’s Guide
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P4FTP startup options
You can specify the following options when you start p4ftpd.
Command Line Flag

Description

-c prefix

Prefix applied to the username in order to derive the name of
the Perforce client to use. Defaults to “ftp-” if not specified.

-C charset

Do not set unless your Perforce server is running in
international mode (ask your Perforce administrator, and
consult the description of P4CHARSET in the Perforce Command
Reference for details.)
Valid settings:
•
•
•
•
•
•

22

utf8
iso8859-1
shiftjis
eucjp
iso8859-15
macosroman

-d

Run as a daemon process (UNIX only), meaning that p4ftpd
does not shut down when the user that started it logs off.

-f

Run in single threaded mode. p4ftpd will service one request
at a time in this mode.

-h

Print the command line syntax and exit.

-i

Started from inetd (UNIX only). Implies -f, because inetd
creates a dedicated P4FTP for each request.

-l port

Specify the TCP port number on which p4ftpd listens for
incoming connections. By default, p4ftpd listens on port 21,
which is standard for FTP servers. On UNIX machines, only
processes started by root can listen on ports below 1024.

-L logfile

Redirect all log messages to the specified file. If not specified,
error messages are directed to stderr
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Command Line Flag

Description

-O p4ftp_option

Specifies various P4FTP settings. Specify each option separately;
for example:
-O dwlocking -O autosync

Valid options are:
dwlocking: uses Dreamweaver file locking to ensure that

Perforce and Dreamweaver each observe the other’s locks.
dw4locking: same as dwlocking for version of Dreamweaver
prior to version 2004.
autosync: enables automatic syncing of the entire client view

every five minutes.
syncdelay n: specifies how often to sync automatically. You can
omit autosync if you specify this option.
syncspec=valid_sync_arg: specifies the portion of the client
view to be automatically synced. Specify valid_sync_arg
using any valid specification for the p4 sync command,
including changelists and wildcards. You can omit autosync if

you specify this option.
keepfiles: prevents P4FTP from deleting files from its
workspace after syncing them. By default, files are deleted, but
if you are using P4FTP for anonymous FTP, this option prevents
race conditions that can occur if two people request the same
file at almost the same time.
-p address

Address of the Perforce server that serves the depot. Defaults to
perforce:1666 if not specified

-s

Redirect all log messages to the syslog daemon (UNIX only).

-T client-template

Specify a Perforce client to be used as a template for clients
lacking a corresponding “ftp-” client specification. For details,
refer to “Specifying a template for undefined client
specifications” on page 17.

-t description

Specify the description to be attached to all changelists created
by P4FTP. Defaults to:
[P4FTP] Automatic changelist for uploaded files

-u username

UNIX only: Specify the username with which the p4ftpd

process runs. Enables you to assign a privileged port (a port
number lower than 1024) to p4ftpd without assigning root
privileges to the process.
Perforce 2006.2 FTP Plug-in User’s Guide
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For example, to start p4ftpd on the local machine on port 21, running with a non-root
user and communicating with the Perforce server running on perforce.myorg.com on
port 1666, issue the following command:
$ p4ftpd -p myftphost:1666 -l 21 -u p4ftpadministrator

Configuring Macromedia Dreamweaver with P4FTP
The following sections tell you how to configure Dreamweaver and Perforce with P4FTP
so you can store your web site files in Perforce depots and access them in Dreamweaver
exactly as you access remote sites using normal FTP.

Overview
The areas you must configure to use Dreamweaver with Perforce are as follows:
• Client workspace: an area of working storage on the computer where P4FTP runs. Must
not overlap the local root.
• Local root: the directory where Dreamweaver stores its working copies of the web site
files for editing.
• Host directory: a path relative to the root of your Perforce workspace, where
Dreamweaver publishes the site's files.
For example, if you’re running Dreamweaver on a Windows computer, P4FTP on a UNIX
computer named ftpserver and the Perforce server on a UNIX computer named
perforceserver, configure as follows:
• Client specification for “ftp-mitch”
• Host: ftpserver
• Client root: /usr/team/mitch
• Client view: //depot/... //ftp-mitch/...
• Dreamweaver configuration for a Web site named “marketing99”
• Local root: c:\dwroot\marketing99
• Host Directory: /main/marketing99/
After you configure Dreamweaver and Perforce, you use Dreamweaver’s Get, Put, Check
In and Check Out menu options to store and retrieve web site files.
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Creating web sites
To use Dreamweaver to create a web site that resides in a Perforce depot, perform the
following steps:
1.

Create a folder on your computer where you want Dreamweaver to store the local
copies of your web site files. (Example: C:\mywebsite).

2.

In Dreamweaver, choose Site>Manage Sites... The Manage Sites dialog is displayed.

3.

Click New...

4.

Enter the local settings for the new site, as illustrated in the following figure.
Important: in the Local Root Folder field, specify an existing directory that does not
reside in your client workspace root.
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5.

In the Category pane, click Remote Info. The Remote Info pane is displayed.

6.

From the Access list, choose FTP. The following fields are displayed.

7.

Make the following entries.

Field

Description

FTP Host

Enter the name of the computer where P4FTP is running and the
port on which it is listening for FTP requests. For example:
myftphost:1234

26

Host Directory

The folder in the depot where you want to store your web site
files. Specify this directory as a relative path (in other words,
omit the client root directory) using the operating system
convention of the computer where you run P4FTP.

Login

Enter your Perforce user name.

Password

Enter your Perforce password, if you have one.
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Check Enable file check in and check out only if you are working in a team
environment, with locking enabled. See “Working in a team environment” on
page 27 for details.
8.

Click OK to save your entries.

You can now use Dreamweaver’s Get, Put, Check In and Check Out menu options to
store and retrieve web site files in the depot.

Sample configuration
The following example provides Perforce and Dreamweaver settings for a web site stored
in a Perforce depot in //depot/websites/site001.
Perforce settings for client workspace
• “ftp-” client root: C:\ftproot
• “ftp-” client view: //depot/... //ftp-myuser/depot/...
Dreamweaver remote settings for site001
• Host directory: depot/websites/site001

Working in a team environment
If you are the only person working on Dreamweaver files, you can use the Put and Get
commands to transfer files between your machine and your web site. However, in team
development environments, you can configure Dreamweaver to lock files when you
check them out, to prevent other users from overwriting your changes. To enable file
locking:
• Start p4ftpd with the -O dwlocking option enabled. Note that dwlocking only works
for Dreamweaver 2004 MX. For older releases use dw4locking.
• Choose Manage Sites>Remote Info and check Enable File Check In and Check Out.
(Note that, when Dreamweaver locks a file, it creates a corresponding .LCK file.)
• Use Check In and Check Out, not Put and Get, when editing files.
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Note that the email address you specify when you enable locking must match the email
address defined for the corresponding Perforce user.

Must match Perforce
user’s email address

(For details about defining Perforce users, see the Perforce Command Reference or use p4
help to display information about the p4 user command.)
After you enable locking for P4FTP, Dreamweaver and Perforce respect each other’s file
locks as follows:
• When you check out a file in Dreamweaver, it is opened for edit and locked in Perforce.
• When you open a file for edit and lock it in Perforce, Dreamweaver treats the file as
checked out.
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Updating a live web site
You can configure Dreamweaver and P4FTP so that, when you check a file in using
Dreamweaver, a live Web site is automatically updated. To set up automatic updating,
you use the autosync option to sync files from a depot to a Web server root. As you check
in files using Dreamweaver, they are synced to the Web site and become live.
To set up a Web site so that, when you check files in using DreamWeaver, your live Web
site is automatically refreshed, perform the following steps. This procedure assumes you
already have a Web site created.
To configure automatic update, perform the following steps:
1.

Create an ftp- client workspace for your Perforce user (example: ftp-tonyz).
This workspace can be rooted anywhere on your machine -- it's a scratch area for
P4FTP.

2.

Create a web site client workspace, rooted in the content area of your web server.
Example: if your web server is Microsoft IIS and you are creating a web site for
Compass Adventures, create a workspace named compass-website., specifying the
workspace root as C:\Inetpub\wwwroot

3.

In the web server root, set up the web site files and verify that you can view them
using a browser.

4.

Using P4V or the p4 command-line client, add the files to the depot (using the web
site client workspace you created in step 2).
For example, add the files to the depot so they reside in
//depot/Compass_WebSite/...

5.

On the Web server machine, set P4CLIENT to the web site client workspace and start
p4ftpd. For example, if your Perforce server is running on myserver:1999, issue the
following command:
p4ftpd -O dwlocking -O syncspec=//depot/Compass_WebSite/... -p myserver:1999

By default, p4ftpd autosyncs every hour. To specify a different interval, use the -O
syncdelay option.
6.

Copy the web site files to a location on your machine where you intend to edit them
using Dreamweaver (not in a client workspace). For example, copy the files to:
C:\Program Files\Macromedia\Dreamweaver 4\Compass_WebSite
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7.

In Dreamweaver, define a web site (choose Manage Sites>New Site...) using the
following settings:
• Local info:
Local root folder: the location where you want to edit files with Dreamweaver. For
example: C:\Program Files\Macromedia\Dreamweaver 4\Compass_WebSite
• Remote info:
Access: FTP
FTP host: machine and port where p4ftpd is running.; for example
mywebserver:21

Host directory: relative path to website files in depot, specified using local syntax.
Leave blank if your web site files are located in a folder at the top level of the
depot.
Login: your Perforce user name.
Enable check-in/check-out and fill in name and email.
8.

Save your settings.

9.

Right-click the top-level folder in the right pane and choose Put. Dreamweaver
populates the left (Remote Site) pane.

Your web site is now configured so that, when you check a file in using Dreamweaver, it
is also synced to the website root and therefore live.
The preceding approach uses a single instance of p4ftpd to support Dreamweaver checkin and to sync the web site. Alternately, you can use separate instances of p4ftpd for each
purpose. Again, the instance that syncs the web site must reside on the machine where the
web site files reside.

Troubleshooting notes: adding files
If you check new files into a directory that does not exist in your Perforce depot,
Dreamweaver displays the following error dialog.

Click OK to dismiss the dialog. The depot directory is created (typically when you exit
Dreamweaver).
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Configuring HoTMetal PRO 6.0
To configure SoftQuad’s HotMetal Pro to access web site files in a Perforce depot, perform
the following steps. (P4FTP must be running.)
1.

Choose Tools>Sites...

2.

Specify the name for your new site.

3.

On the Choose Connection Method dialog, click the I connect to my site via FTP
radio button and click Next.

4.

On the FTP settings dialog specify the following:
• Host Name: the computer where P4FTP runs
• User ID: your Perforce user ID

5.

If you intend to run P4FTP on a port other than the default (21), click Advanced FTP
Settings... and specify the port on the Advanced FTP Settings dialog.

6.

On the Choose FTP Default Folder dialog, specify the depot location for your web
site. Example: depot/websites. The depot location must already exist. Note that, if
P4FTP is running, you can click the browse button and browse the depot to specify
the location.

After you finish configuring the site, you can create projects and transfer files between
your computer and the Perforce depot.

Configuring Hot Dog Professional 6
To obtain access to files in a Perforce depot using Hot Dog Professional 6, define a remote
site as follows. (P4FTP must be running.)
1.

Choose Open Remote... The Open dialog is displayed.

2.

Double-click Add Internet Site. The Internet Site Wizard is launched.

3.

In the What is your Server Address? field, specify the computer where P4FTP is
running.

4.

In the What is your Login Name? field, specify your Perforce user name. (If you have
a password, specify it in the What is your Password? field.). Click Advanced.

5.

In the Advanced Server Details dialog, specify the port number on which P4FTP is
configured to listen (the value specified with the p4ftpd -l flag).

After you configure the remote site, you can access the files in the depot by choosing
Open Remote and double-clicking the site.
Perforce 2006.2 FTP Plug-in User’s Guide

31

Chapter 1: Installing and Configuring P4FTP

Configuring AceHTML
To use P4FTP with AceHTML, you must install AceFTP. To configure access to a Perforce
depot, run AceFTP and configure a remote site as follows. (P4FTP must be running.)
1.

Choose File>Connect. The Session Properties dialog is displayed.

2.

On the General tab, make the following entries:
• Host Name: the name you want to assign to the host
• Host Address: the fully-qualified domain name of the computer where P4FTP is
running
• User ID: your Perforce user name.

3.

Click the Additional tab and enter the port number on which P4FTP is configured to
listen (the value specified with the p4ftpd -l flag).

4.

Click Connect.

5.

If prompted, enter your Perforce password.

AceHTML displays the depot contents in its right pane. Use the Edit menu Upload files
and Download files commands to transfer files between the depot and your client
computer.
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This chapter provides information to help you determine what to do if a P4FTP does not
succeed or you do not understand the results of an operation.

Error messages
Cannot make connection to host
Make sure:
• P4FTP is running.
• You are connected to the FTP server (Dreamweaver)
• You entered your Perforce user name in the web site’s remote configuration
(Dreamweaver).

Cannot open remote folder
(Dreamweaver) The folder specified as the Host directory in a site’s remote configuration
does not exist, or the Perforce client specification Host field specifies a computer other
than the one where P4FTP is running.

Can’t clobber writable file
(Dreamweaver) Verify that your client workspace directory does not reside in your web
site’s local root, or vice versa.

Error opening local file
You are attempting to get a file when a read-only copy already resides on your computer.
(Perforce sets a file’s protection to read-only when you do not have the file open for edit.)

Other questions
Why aren’t my Dreamweaver files visible in Perforce?
When you use P4FTP to connect Dreamweaver to a Perforce depot, your changes are made
when you disconnect from the remote site (choose Site>Disconnect). If you are
monitoring changes to the depot using P4Win, for example, refresh its display after you
disconnect and your Dreamweaver changes are displayed.
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I created a directory using FTP and it disappeared - why?
If you connect to P4FTP using a command-line FTP client and use the MKDIR command to
create a directory in a Perforce depot, Perforce removes that directory when you
disconnect unless the directory contains files. To ensure that the directory remains, you
can use the FTP “put” command to upload a file to it. Note that the file you upload is
added to the Perforce depot when your FTP client disconnects from p4ftpd.

My command-line FTP client/Dreamweaver froze after
connecting/prompting for P4FTP - why?
Windows computers: if you started P4FTP from a DOS window, check whether characters
have been selected in the startup window. To unselect the characters (and unfreeze the
FTP client), click in the window where you started P4FTP and press Enter.

Why do I have .lck files in my workspace/depot?
If you enable Checkin/Checkout, Dreamweaver creates .lck files in your workspace
when you check files out and deletes the .lck files when you check files in. However, for
Dreamweaver locking to work correctly with P4FTP, you must also enable Dreamweaver
locking (specify the -O dwlocking option) when you start p4ftpd. If you do not enable
Dreamweaver locking, P4FTP automatically checks in the .lck files along with the
associated HTML files.
Fix: restart p4ftpd, specifying the -O dwlocking option. To remove all .lck files from
your depot, you can use the p4 obliterate command, but before doing so, be sure to
observe all the precaution described in the Perforce System Administrator’s Guide.

Using a command-line FTP client
You can use an FTP command-line client to interact with a Perforce depot through P4FTP.
P4FTP also supports Perforce-related commands. To display a list of Perforce-related
commands, issue one of the following commands:
• UNIX: rhelp
• Windows: remotehelp
The following Perforce-related command is supported.
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Command

Description

SITE REVERT <full_file_path>

Manually revert a file open for edit
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This chapter describes how P4FTP differs from standard FTP and from Perforce.

FTP differences
This section describes how P4FTP differs from standard FTP.

How files are managed on the client computer
In a standard FTP site, all users share access to an area of storage and, depending upon the
permissions in place, they might overwrite each others’ work. P4FTP uses a Perforce
approach, in which each P4FTP user has a private workspace that is mapped to shared
areas of the Perforce depot. When a file is uploaded, it is opened for add or edit as
appropriate, and locked. When the file is submitted, it becomes the new head revision.
Another user who has the same depot path in their FTP client workspace can then
download the updated version of the file.
P4FTP uses its client workspaces as temporary storage. Operations such as directory
listings are performed by querying the Perforce server, and are always up-to-date.

How files are transferred
Standard FTP transfers files one at a time, and there is no facility for grouping changes.
One of the key benefits of Perforce is that related changes are grouped together into
changelists. P4FTP groups all changes (adds, edits and deletes) made in a single FTP
session into one changelist that is submitted at the end of the session.
The following sections describe how your files are transferred between your client
computer and a Perforce depot.
Saving files
When you use the put command from an FTP client, your files are added to a Perforce
changelist in preparation for submission to the depot. When you close your connection,
the changelist is submitted and the files are saved to the depot.
When you use the Save or Publish feature of your web authoring tool, your files are added
to a Perforce changelist in preparation for submission to the depot. When you disconnect
from P4FTP, the changelist is submitted and the files are saved to the depot. Note that a
newly uploaded file is not visible to other P4FTP or Perforce users until the submitting
user closes its FTP connection.
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Getting files
When you use the get command from an FTP client, the Open feature of your web
authoring tool, or download a file using a Web browser, the files are synced from the
depot to your client computer and are immediately visible on the client computer.

The pwd command
The FTP command pwd (print working directory) normally displays the current directory
on the remote computer. When you use P4FTP, the pwd command displays the Perforce
depot directory but uses the client operating system convention.
For example, if you are connecting from a Windows computer to a depot on a UNIX
computer, when you issue the pwd command, the working directory might be displayed
as c:\p4client-test\depot.

Supported FTP commands
The following FTP commands are supported by P4FTP. The names in braces are the
commands used by common FTP clients, and the uppercase names represent the actual
protocol commands.
• ACCT (account)
• CDUP (cdup)
• CWD (cd)
• DELE (delete / rm)
• HELP (rhelp/remotehelp)
• LIST (ls / dir)
• MDTM (modtime)
• MKD (mkdir / md)
• NLST (nlist)
• NOOP
• PASS

• PASV (passive)
• PORT

• PWD (pwd)
• QUIT (quit / bye)
• RETR (get)
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• RNFR (rename)
• RNTO (rename)
• SIZE (size)
• STAT (rstat)
• STOR (put)
• STRU (stru)
• SYST (system)
• TYPE (ascii / binary)
• USER (user)
• XCDUP (cdup)
• XCWD (cd)
• XMKD (mkdir / md)
• XPWD (pwd)

Perforce differences
This section documents the differences in behavior between P4FTP and a normal Perforce
client interface. Due to the nature of the FTP protocol, users of P4FTP do not have access to
the full functionality provided by Perforce.

Changelist numbering
P4FTP uses only the default changelist. If a submit fails for any reason, Perforce turns the
default changelist into a numbered changelist. To ensure that files opened under
numbered changelists do not become abandoned, P4FTP consolidates all files opened on a
client into the default changelist. Users can resolve most problems by simply retrying,
without the assistance of an administrator.

Changelist descriptions
Due to the design of the FTP protocol, P4FTP cannot prompt the user for a description
when a changelist is submitted, so a default description is used. If the ability to describe
changelists is important to you, use the P4 command line client or P4V.
To override the default change description, specifying the desired description using the t command line flag when you start P4FTP.
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Filetypes
For new files being uploaded to the server, P4FTP uses the Perforce filetype detection
mechanism to determine whether a file is a text file or a binary file. For files that already
exist on the server but are being updated, P4FTP uses the filetype of the previous revision
so that files marked as ktext or binary+S, for example, retain this type of information.

Workspace management
A standard Perforce client workspace is populated with revisions of files in the depot, and
is periodically synced to the head revision to obtain changes made by other users. Because
P4FTP uses its client workspace only for temporary storage, users do not need to sync to
keep the workspace up to date.
P4FTP stores the following types of files in client workspaces:

• Files uploaded by the user and open for add or edit
• Files being downloaded to the user and synced to the head revision
The client workspace used by P4FTP provides:
• An isolated area of temporary storage.
• An identifier for Perforce to use to track open files and submissions.
• A workspace that an administrator can use to correct errors.
After every successful submission, all files in the submitted changelist are removed from
the client workspace using p4 sync filename#none. When a user requests a file from
P4FTP using the FTP get command, P4FTP retrieves the head revision of the file from the
depot, transfers it to the user and then removes it from its workspace by syncing it to
#none. This feature enables large areas of the depot to be mapped without wasting disk
space.
The only files that are typically present in the client workspace are files that the user is
actively using. To prevent empty directories from cluttering the client workspace, you
enable the rmdir option when you create clients specifications.
To diagnose client workspace problems, use the p4 command or P4V.

Concurrency
All files opened for add or edit and delete are locked by P4FTP to prevent other users
from submitting their change first and thereby denying P4FTP access to the head revision.
If a file is locked when a user tries to upload it using P4FTP, permission is denied until the
lock is released.
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Standards compliance and limitations
P4FTP is broadly compliant with the requirements of RFC 959 and RFC 1123. RFC 959
specifies that, though the telnet protocol is used on the FTP control channel, it is not the
intention that the entire telnet protocol be implemented on this channel. RFC 1123 clarifies
this requirement by stating that FTP servers must support the telnet IP and SYNCH
commands and, although they are not required to support telnet option negotiation, they
should be capable of refusing option requests (that is, responding with DONT/WONT).
P4FTP does not currently recognize any telnet option negotiation. (Few, if any FTP clients
use this option negotiation.)

Note the following limitations:
• P4FTP contains no support for restarting FTP transfers. All transfers must transfer the
entire file.
• P4FTP contains no support for appending to files as specified in the RFCs.
• Symbolic links appear in directory listings, but attempts to download linked files result
in an error.
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